Getting Started Tutorial

EDHIS
TUTORIAL

Chapter

This tutorial provides complete examples for two uses of EDHIS. The first
example is a low-speed collision, where the occupant motion is simulated in an
effort to determine the potential for injury. The second example is a pedestrian
impact, where the issue is the speed of the striking vehicle. These examples
illustrate common applications of EDHIS.

Like all EDHIS events, the procedure involves the following basic steps:

* Create the humans
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* Create the vehicles

* Create the environment

» Execute the EDHIS events

* Review the EDHIS output reports

This basic procedure is described in detail in this tutorial.

NOTE: It is assumed that HVE is up and running, and
that the user is familiar with HVE’s basic features, such
as using HVE’s dialogs and viewers, as well as the HVE
Editors. The purpose of this tutorial is to illustrate those
features while setting up and executing an EDHIS event.

Getting Started

Asin other tutorials, before we get started with our current tutorial, let’s set the
user options so we’re all starting on the same page.
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5> NOTE: Most options simply affect the appearance in a
viewer during Event or Playback mode. However, some
options affect the data used in the analysis. For example, if
AutoPosition is On, the vehicle position conforms to the local
surface; otherwise, the position is set by the
Position/Velocity dialog. Obviously, the resulting difference
in initial conditions could substantially change the event.

5> NOTE: Some of the following options are “Toggles” that
switch between two different modes. Make sure these
options are set correctly.

To set the initial user options, choose the following from the Options Menu:

> ON: Show Key Results
> OFF: Show Axes
> ON: Show Contacts
> OFF: Show Velocity Vectors
> ON: Show Skidmarks
> OFF: Show Targets
> ON: AutoPosition
> Units equals US
> Render Options:
» Show Humans as Actual
» Show Vehicles as Actual
* Phong Render Method
* Complexity equals Object
* Render Quality equals 5
» Texture Quality equals /
* Anti-aliasing equals /
The remaining options will automatically initialize to their default conditions.
We’re now ready to proceed with the tutorial.

Creating the Humans

To create the humans forboth events (the occupant in the intersection collision
and the pedestrian in the pedestrian impact), perform the following steps:

> If the HVE Human Editor is not the current editor, choose
Human Mode.

First, let’s add the human occupant to the case.
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> Click Add New Object. The Human Information dialog is
displayed. The Human Information dialog includes option
buttons allowing the user to select a seat position within the
vehicle (alternatively, Pedestrian could be selected), and
assign the human’s attributes according to Sex, Age, Weight
Percentile and Height Percentile.

> Using these option buttons, click each button to choose the
following human attributes:

* Location = Front, Left (i.c., driver)

@ NOTE: By definition, we must choose sides here. We're
going to assign the driver’s position to the left side of the
vehicle (sorry to our friends in Great Britain, Australia and
other countries whose drivers are stuck on the wrong
side of the vehicle!).

* Sex = Male
* Age = Adult
* Weight Percentile = 50
* Height Percentile = 50
> Edit the default human name: Male Adult Driver.
> Click OK to add Male Adult Driver to the Active Humans list.

Now, let’s add the female pedestrian.

> Click Add New Object. The Human Information dialog is
displayed.

> (Click onthe optionbuttons in the Human Informationdialog to
choose the following human attributes:
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* Location = Pedestrian
* Sex = Female
* Age = Adult
* Weight Percentile = 50
* Height Percentile = 97.5
> Edit the default name: Female Adult Pedestrian.

> Click OK to add Female Adult Pedestrian to the Active
Humans list.

5> NOTE: By choosing Pedestrian, HVE will define the
human’s motion relative to the earth-fixed coordinate
system (occupant motion is defined relative to the
vehicle-fixed coordinate system).

Afterthe above steps are performed, both humans have been added to the case
and are ready to be analyzed.
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Figure 5-1 Male Adult Driver (above) and Female Adult Pedestrian (below), ready for
analysis.
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Creating the Vehicles

Now we have our humans, so let’s add the vehicles. First, let’s add the two
vehicles involved in a low-speed, rear-end collision. One vehicle is a dark red
1991 Buick Skylark and the second is aforest green 1989 Ford F-150 Pickup:

> Choose Vehicle Mode. The Vehicle Editor is displayed.

> Click Add New Object. The Vehicle Information dialog is
displayed. The Vehicle Information dialog allows the user to
select the basic vehicle attributes according to 7ype, Make,
Model, Year and Body Style.

5> NOTE: The Vehicle Information dialog also allows you to
edit the Driver Location, Engine Location, Number of
Axles and Drive Axle(s). These options affect the basic
vehicle configuration and do not need to be changed for
our tutorial.

> Using the option buttons, click each button to choose the
following vehicle from the database:

* Type = Passenger Car
* Make = Buick

* Model = Skylark

* Year= [985-1991

* Body Style = 4-Door

> Click OK to add Buick Skylark 4-Dr to the Active Vehicles
list.
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Now, let’s add the 1989 Ford F-150 pickup:
> Click Add New Object. The Vehicle Information dialog is
displayed.

> (lick on the option buttons in the Vehicle Information dialog
to choose the second vehicle according to the following
attributes:

* Type = Pickup

* Make = Ford

* Model = F-150

* Year= 1988-1991

* Body Style = Fleetside

> Click OK to add Ford F-150 Fleetside to the Active Vehicles
list.
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Figure 5-2 Buick Skylark 4-Dr (above) and Ford F-150 Fleetside (below).
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Finally, let’s add the aqua blue 1997 Plymouth Van to the case. The Plymouth
Van was involved in the pedestrian impact.

> Click Add New Object. The Vehicle Information dialog is
displayed.

>> (lick on the option buttons in the Vehicle Information dialog
to choose the following vehicle from the database:

* Type=Van
* Make = Plymouth
* Model = Voyager
* Year = 1996-1999
* Body Style = VVan
> Click OK to add Plymouth Voyager Vanto the Active Vehicles
list.

Now, we have all the vehicles required for our case, as shown in Figure 5-2.
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Figure 5-2 (cont) Plymouth Voyager Van.
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Editing the Vehicles

Next, we will edit the vehicles to change their color. In addition, we need to add
contact surfaces to the Buick and Plymouth Van for the human simulations.
The contact surfaces are the physical surfaces that interact with the human
ellipsoids to produce forces.

Let’s start with the Buick. This vehicle was struck from the rear, and we wishto
simulate its occupant during the low-speed impact.

To edit the Buick, perform the following steps:

> First, select the Buick Skylark 4-Dr from the Active Vehicles
drop-downlist, makingit the currentvehicle. The Buick is now
displayed in the Vehicle Editor.

Let’s remove a portion of the vehicle exterior so we can see inside the vehicle
more easily. The HVE 3-D Editor was previously used to remove the
passenger compartment, and we saved the modified geometry file by the name
PCBuickNoTop.h3d To assign the modified geometry file:

> Click on the CG and choose Geometry File, Open. The
Drawing File Selection dialog is displayed. Double-click on
PCBuickNoTop.h3d. The vehicle is redisplayed with the new
geometry file exposing the vehicle interior.

> To change the vehicle’s color from bright red to dark red, click
on the CG and choose Color. The Vehicle Color dialog is
displayed (see Figure 5-3), showing the vehicle’s current color
(the small black square in the color wheel) and intensity (the
arrow in the infensity slider). Leave the color unchanged; to
darkenthe vehicle, click on the intensity slider and drag it from
the right end of the slider towards the middle.

5> NOTE: The color chip on the left shows the current color.

> When the color is darkened to your liking, press the Close
button to apply the new vehicle color.

5> NOTE: The vehicle’s apparent color may be slightly
misleading because the vehicle is translucent when
displayed in the Vehicle Editor. The actual color will be
used whenever the vehicle is displayed during Event and
Playback mode.
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Next, let’s add the contact surfaces for the Buick. We’ll need a minimum of
three surfaces for our simulation: a seat bottom, a seat back and a head rest, as
shown in Figure 5-4.
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Figure 5-4 Seat Bottom, Seat Back and Head Rest contact surfaces.
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Figure 5-5 Contact Surface dialog.

To add the contact surfaces, perform the following steps:

> Click on the CG and choose Contact Surfaces. The Contact
Surfaces dialog is displayed (see Figure 5-5), and we’re ready
to create the contact surfaces for the Buick.

> Click Add and enter Seat Bottom, followed by <Enter>.

> [nterior is already selected as the default location to identify
this contact as an interior contact surface.

> Enterthe coordinates for 3 corners of the seatbottom, as shown
in the table below:

Table 5-1 Seat Bottom Contact Surface Coordinates

Corners (Counter-clockwise)

First Corner Middle Corner | Third Corner

X -23.0 -3.0 -3.0
y -3.0 -3.0 -23.0
z 1.0 -2.0 -2.0
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5> NOTE: Remember to enter three consecutive comers in
counter-clockwise order to establish the positive side of
the surface.

5> NOTE: The order is important! If we enter the coordinates
in the wrong order, no force will be produced between the
human and vehicle.

5> NOTE: You can tab between fields in this dialog, making
it quicker to enter the coordinate data.

The Seat Bottom contact surface is complete. Next, let’s create a contact
surface for the seat back:

> Again, click 4dd and enter Seat Back, followed by
<Enter>. Interior is already selected. Enter the coordinates
for three corners of the seat back (Table 5-2):

Table 5-2 Seat Back Contact Surface Coordinates

Corners (Counter-clockwise)

First Corner l(\zﬂggg Third Corner
X -21.0 -21.0 -28.0
y -3.0 -23.0 -23.0
z 2.0 2.0 -18.5

Finally, let’s create a contact surface for the head rest:

> Again, click 4dd and enter Head Rest, followed by
<Enter>. Interior is already selected. Enter the coordinates
for three corners of the head rest (Table 5-3):

Table 5-3 Head Rest Contact Surface Coordinates

Corners (Counter-clockwise)

First Corner gggleer Third Corner
X -28.0 -28.0 -28.5
y -7.0 -19.0 -19.0
z -21.0 -21.0 -25.0
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Figure 5-6 Buick Skylark 4-Dr after adding contact surfaces for the seat and headrest.

> Click OK to remove the Contact Surface dialog.
The Buick is displayed with it’s the surfaces, as shown in Figure 5-6.

NOTE: Ifthe contact surfaces are not displayed, choose
Options in the main menu bar and click on Show
Contacts.

Using the viewer thumb wheels, rotate the vehicle and look at each side of the
surfaces. Note the contact side is light colored (i.¢., the positive side), while the
other side is dark.

Now, let’s change the color of the Plymouth Van, and add Bumper, Grill, Hood
and Windshield contacts to its exterior (see Figure 5-7). These contact surfaces
will be used for the pedestrian impact simulation.

To change the vehicle’s color from red to blue, perform the following steps:

> Select the Plymouth Voyager Van from the Active Vehicles
drop-down list, making it the current vehicle. The vehicle is
displayed in the viewer, ready to edit.
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(10.0,-35.0,-33.0)

Windshield

(40.0,-35.0,-16.0)

(77.0,-35.0,-4.0)

(40.0,35.0,-16.0) (83.0,-35.0,7.0)

(77.0,-35.0,15.0)
(77.0,35.0,-4.0)

(83.0,35.0,7.0) Bumper
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Figure 5-7 Bumper, Grille, Hood and Windshield contact surfaces.

> Click onthe CG and choose Color. The Vehicle Color dialogis
displayed, showing the vehicle’s current color (in the color
wheel) and intensity (in the intensity slider). Click on the hot
spot (the small black square in the color wheel) and drag it to
the middle of the blue area. Next, darkenthe vehicle slightly by
dragging the intensity slider from the right end of the slider
towards the middle.
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5> NOTE: The color chip on the left shows the current color.

> When the color is to your liking, press the Close button to
apply the new vehicle color.

To create the contact surfaces for the van, perform the following steps:
> Click on the CG and choose Contact Surfaces. The Contact
Surfaces dialog is displayed.

> Click Add and enter Bumper, followed by <FEnfer>. Click
on Exterior and enter the coordinates for 3 corners of the front
end (Table 5-4, following page).
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Table 5-4 Plymouth Van Bumper Contact Surfaces

Corners (Counter-clockwise)

First Corner ncﬂggg Third Corner
83.0 77.0 77.0
35.0 35.0 -35.0

7.0 15.0 15.0

Now, let’s create the Grille contact surface:

> Again, click Add and enter Grille, followed by <Enfer>.
Click on Exterior and enter the coordinates for three corners of the
grille:

Table 5-5 Plymouth Van Grille Contact Surface Coordinates

Comers (Counter-clockwise)

First Corner | Middle Corner | Third Cormer
83.0 83.0 77.0
35.0 -35.0 -35.0

7.0 7.0 -4.0

Now, let’s create the Hood contact surface:

> Again, click Add and enter Hood, followed by <FEnter>. Click
on Fxterior and enter the coordinates for three corners of the
hood: (Table 5-6, following page).

The last contact surface for the Plymouth Van is the Windshield:

> Again, click Add and enterWindshield, followed by <Enter>.
Click on Exterior and enter the coordinates for three corners of the
windshield (Table 5-7, following page).

> Click OK to remove the Contact Surface dialog.

The vehicle is displayed with it’s the surfaces, as shown in Figure 5-8.
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Table 5-6 Plymouth Van Hood Contact Surface Coordinates

Corners (Counter-clockwise)

First Comer | Middle Corner | Third Corner
X 40.0 77.0 77.0
y 35.0 35.0 -35.0
z -16.0 -4.0 -4.0

Table 5-7 Plymouth Van Windshield Contact Surface Coordinates

Corners (Counter-clockwise)

First Corner | Middle Corn Third Corner
X 40.0 40.0 10.0
y 35.0 -35.0 -35.0
z -16.0 -16.0 -33.0

B (& Yo ok jew QLS Qo Beb

D@~

¥ [+ @ [Frymaun vopager van EEE
AeRE o tue h

ABDaT

-
g
o
(@)
[
=)

-

|

(T —

Zoms| | 2 e oy
=

Figure 5-8 Plymouth Van after adding the Bumper, Grille, Hood and Windshield
contact surfaces.
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Again, use the viewer thumb wheels to rotate the vehicle and look at each side
of the surfaces. Note the contact side is light colored (i.e., the positive side),
while the other side is dark.

Finally, let’s change the color of the Ford pickup from red to forest green:

> Click on Ford F-150 Fleetside in the Active Vehicles list. The
vehicle is displayed in the viewer, ready to edit.

> Click onthe CG and choose Color. The Vehicle Color dialogis
displayed, showing the vehicle’s current color (in the color
wheel) and intensity (in the intensity slider). Click on hot spot
in the color wheel and drag it to the middle of the green area.
Next, darken the vehicle by dragging the intensity slider from
the right end of the slider towards the middle. Remember, the
color chip on the left shows the current color.

> When the color of the Ford Pickup is to your liking, press the
Close button to apply the new vehicle color.

We now have all three vehicles required for the two simulation studies in this
case.
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Creating the Environment

Now, let’s add the environment.

> Choose Environment Mode. The Environment Editor is
displayed.

Let’s use one of the sample environments shipped with HVE.

> Click on Add New Object. The Environment Information
dialog is displayed.

> Using the Location Database combo box, choose Beaverton,
Oregon, USA. The latitude, longitude and GMT (hours from
the prime meridian) are displayed for the selected location.

> Edit the date and time of the incident we are studying,
4-22-96 and 1630, respectively.

> Edit the angle from frue north to the earth-fixed X axis in our
environment, 56 degrees.

[[g NOTE: The Latitude, Longitude, GMT, Date/Time and
angle from true north are used to position the sunin the
scene. This is, of course, important because the sunis
the primary light source for the scene.

> To add the environment geometry file to our case, click on
Open. The Environment Geometry File Selection dialog is
displayed.

> Click onthe File of Type optionlist and choose 13d Files. A list
of environment geometry files using the HVE file format is
displayed in a list box.

> Double-click on 274 Intersection.h3d to choose the
environment file and remove the dialog.

> Press OK.
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The selected environment is added to our case and displayed in the
Environment Viewer (see Figure 5-9). Use the viewer thumb wheels to view
the scene.
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Figure 5-9 3-D Environment used for our tutorial.

Saving the Case

Now that we ve created all the objects (humans, vehicles and environment) for
our case, let’s save the case file.

> Click on the File menu and choose Save. The Save-as File
Selection dialog is displayed.

5> NOTE: The Save-as dialog is displayed because the
case has not been saved previously, so we need to enter
a filename.

> In the Case Title text field, replace Untitled with EDHIS
Tutorial Case.

5> NOTE: The Case Title is displayed as a heading on all
printed output reports.

> In the Filename text field, enter EdhisTutorial.

> Click SAVE. The current case data arc saved in the
hve/supportFiles/case subdirectory.

5> NOTE: Saving the file occasionally is a highly
recommended practice.
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Creating the Events

We are going to perform two simulation studies: one study is an occupant simulation
of a low-speed, rear-end collision and the other is a pedestrian impact.

Collision Simulation

Forthe low-speed rear-end collision, we need a collision pulse. We can get the
collision pulse directly using the EDSMAC4 collision simulator:

[ NOTE: If you don't have EDSMAC4 on your HVE system,
you may skip the EDSMAC4 event. The collision pulse
for this event is shipped with HVE, and may be loaded by
selecting Edhis TutorialCollisionPulse from the Collision
Pulse File Selection dialog.

> Choose Event Mode. The Event Editor is displayed.

> Click on Add New Object. The Event Information dialog is
displayed.

> Select Buick Skylark 4-Dr and the Ford F-150 Fleetside from
the Active Vehicles list.

> Select EDSMAC4 from the Calculation Method options list.

> Enter a name for the event, Buick vs Ford.

5> NOTE: HVE will append the name of the calculation
method to the event name, thus the complete event
name will become "EDSMACA4, Buick vs Ford.”
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> Press OK to create the event and display the event editor.
Now, we’re ready to set up the first event.

> Choose Sef-up from the menu bar and select Position/Velocity.
The Buick is displayed at the earth-fixed origin.

> (Click on the vehicle’s X-Y manipulator (see Figure 5-10),
wait for it to turn bright yellow (indicating it has been
selected), and drag it to its impact position, X=24 ft, Y=75 ft.
Click the yaw manipulator and rotate it to its heading angle,
-90 degrees.

[ NOTE: Be sure to keep the mouse button depressed
while you drag the manipulators.
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Figure 5-10 Positioning the Buick Skylark using the manipulators.

5> NOTE: Adjust the viewer by dollying back (using the Dolly
thumb wheel) until you can see the entire intersection.

[Ig NOTE: To select the X-Y manipulator, the viewer must be
in Pick mode, as indicated by the highlighted arrow in the
upper right corner of the viewer (see Figure 5-10).

5> NOTE: If you can't position the vehicle at the exact
coordinates, simply enter them in the dialog (in fact, it’s
often easier to directly enter the coordinates using the
dialog).

> Click the Velocity Is Assigned checkbox. Since it was stopped
at impact, leave the value assigned at 0 mph.

Event set-up for the Buick is now complete. Let’s set up the Ford pickup.

> Select Ford F-150 Fleetside in the Event Humans & Vehicles
list, then choose Position/Velocity from the Sef-up menu. The
Ford is displayed at the earth-fixed origin. Drag it to its impact
position, X=24 ft, Y=91 ft, Yaw=-90 degrees. Click
Velocity Is Assigned, and enter an initial velocity of 10 mph.
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Figure 5-11 HVE Event Editor executing the EDSMAC4 Event.
> Choose Simulation Controls from the Options menu and

change the Output Time Interval from 0.1 secto 0. 005 sec.
Click OK to accept the change.
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[S° NOTE: We reduced the output interval because we're
going to use the acceleration output from this simulation
as the collision pulse for our occupant simulation, so we
want more detail; selecting the smaller output interval
provides the acceleration at 0.005 second increments,
rather than the default value, 0.1 second. Note the entire
duration of a collision is only about 0.1 second, so the
default interval might actually skip the entire collision!

> Using the Event Controller, click P/ay to execute the event.
Allow the event to run until just after the vehicles separate,
t=10.20 sec. Then press Pause/Stop to end the event.

The EDSMAC4 event is shown in Figure 5-11.

ng’ NOTE: While the event is executing, watch the current
results (especially acceleration) in Key Results windows.
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Occupant Simulation

The EDSMAC4 event has provided us with the collision pulse; now let’s use
EDHIS to study the driver’s behavior during impact.

> Select Add New Object. The Event Information dialog is
displayed.

> Select Buick Skylark 4-Dr and the Male Adult Driver from the
Active Vehicles list and Active Human list, respectively.

> Select EDHIS from the Calculation Methods options list.
> Enteraname forthe first EDHIS event: Bui ck Occupant.
> Press OK to display the event editor.

Now, let’s set up and execute the occupant simulation event using EDHIS:

> Using the Event Editor dialog, select Buick Skylark 4-Dr from
the Event Humans & Vehicles list, then select Sef-up from the
menu bar and choose Position/Velocity. The Buick is
displayed at the earth-fixed origin.

> Use the Position/Velocity dialog to assign the same initial
position as the one used in the previous EDSMAC4 event,
X=24 ft, Y=75 ft and heading=-90 deg.

5> NOTE: Be sure to press <Enter> to apply the values
displayed in the Position/Velocity dialog.

> Click the Velocity Is Assigned check box. Leave the value
assigned at O mph.

> Choose Collision Pulse from the Set-up menu. The collision
pulse dialog is displayed (see Figure 5-12). Click on the Pulse
Data Source optionlist and choose EDSMACY, Buick vs Ford.
The collision pulse (acceleration vs time history) for the Buick
Skylark during the low-speed impact is displayed numerically
(in a user-editable table) and graphically.

> Press OK to accept the collision pulse.

Before we position the human, we’ll attach the camera to the vehicle.

5> NOTE: This tip really helps while positioning occupants
because it allows you to move the camera relative to the
vehicle, thus you can quickly focus on the interaction
between the human and the seat cushion, an important
part of placing the human in an equilibrium position.
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Collision Pulse: Buick Skylark 4-Door
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Figure 5-12 Collision Pulse dialog for Buick Skylark.

To attach the camera to the vehicle, perform the following steps:

> Choose Set Camera from the View menu. The Set Camera

dialog is displayed (sec Figure 5-13).

> Clickthe View From option list and choose Buick Skylark 4-Dr.

> Enter the Camera Position coordinates, x=0, y=-20, z=0.

> Enter the Camera Center coordinates, x=0, y=0, z=0.

> Press OK.
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The viewer displays the vehicle as viewed from the vehicle-fixed coordinates,

0,-20.0.

Now we’re ready to position the driver in the Buick.

> Select Male Adult Driver from the Event Humans & Vehicles
list, then choose Position/Velocity from the Set-up menu. The
occupant is displayed at the vehicle-fixed origin. A set of
manipulators is attached to the human to allow us to position
him in the seat (refer to Figure 5-14).

5> NOTE: The Position/Velocity dialog displays the current
position and orientation of the human relative to the
vehicle-fixed coordinate system.
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Camera Setup EE
Wiews From :
Camera Coordinates - = [ft): IEI.EI

Y |-200
Z: [oo

Ficture Center - % [ft] . |0.0
Y[f): |00
Z[ft): |00

Drepth of figld - Mear [ft] :
Far [ft]: {20000

T

Focal Length [mm] :  |50.00

(] I Cancel | Apply |

Figure 5-13 Set Camera dialog, used for
attaching the camera to the vehicle and
setting the view.
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Figure 5-14 Human manipulators used for positioning the human.
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To position the occupant, let’s first use the x-y plane manipulator to position
the human over the middle of the seat at x=-17 in, y = -13 in.

> (Click on the x-y plane manipulator (a white, horizontal plane
through the human’s pelvis segment) and drag the human to
x=-17, y=-13, then release the mouse.

> NOTE: You may wish to use the rotX thumb wheel to get
a better view of the human relative to the seat.

@ NOTE: Ifthe human is not located exactly at -17,-13, you
can enter the values directly in the Position/Velocity dialog.

Use the z manipulator (a white rod along the human’s z axis) to set the
elevation.

> (Click on the z manipulatorand drag the humanup to - 5 inches
(again, you may use the dialog to enter the exact value).

Next, we’ll use the pitch manipulator to lean the occupant back in the seat:

> Click on the purple pitchband and drag the human, tilting him
back until the pitch equals 30 degrees.

5> Again, you may wish to use the rotX and rotY thumb
wheels to gain a better view. You might also want to
rotate the scene to get a better angle on the pitch
manipulator band in order to select it.
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Now the human is seated properly, but his legs protrude through the floorboard
(we won’t make the obvious comment!). Let’s position the legs:

> Click on the lower left leg. The orientation manipulators are
displayed.
> Click on the pitch manipulator and drag the leg until the pitch
angle is -30. 0 degrees.
> Repeat the above two steps to position the lower right leg.
The human is now properly positioned in the seat. The last step in positioning
is to assign an initial velocity:

> (lick on the human pelvis segment in order to select it.

[@ NOTE: We must select the pelvis, which is the main
segment, in order to assign an initial velocity to the
human; otherwise, we would have simply assigned an
initial velocity to the lower left leg.
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> Click the Velocity Is Assigned checkbox in the
Position/Velocity dialog, and enter a forward velocity of 0
mph.

5> NOTE: Because the human is defined as an occupant (as
opposed to a pedestrian), the initial velocity is defined
relative to the vehicle.

The final step in the event set-up is to set up contacts and assign combined
material property data for the humanellipsoid to contact surface interactions:

> If the Male is not currently selected in the Event Humans and
Vehicles list, click on it, making it the current object.

> Choose Contacts from the Set-up Menu (Figure 5-15).
> Under the Objects list, click Select All.
> Under the Targets list, click Select All.

> Below, in the Combined Material Properties section, click
Select All.

Contact Interactions - Male Adult Driver

Object : |Maleﬁ3«dultDriver IBuick Skylark. 4-Door j

Source (3] Target [g]

Select Al Dezelect Al Select Al Dezelect Al

Combined Material Properties :

Segment(s] :

Far : IMU“iP'E And:

et | Deselectal

Current Material ; |Typical Seat

Ok Cancel |

Figure 5-15 Combined Material Properties dialog.
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> Click Fdit to edit the combined material properties.

> Click Open to open a saved combined material property data
set.

> Double-clickon TypicalSeat.matl to selectit and close
the dialog.

> Click OK to accept the new material properties.
> Click OK to accept the assigned contacts.

The contacts are now assigned and we are ready to proceed with executing the
simulation.

Since our goal for this event is to study how the impact severity affects force
and head acceleration, let’s look at some Key Results during execution:

> If Key Results windows are not displayed, choose Show Key
Results from the Options menu.

> Dragthe Key Results windows to a convenient location, where
they do not block the view but still allow us access to the
viewer thumb wheel controls (in case we want to change the
view).

> Click onSelect Variable inthe Male Adult Driver Key Results
window. The Variable Selection dialog for Male Adult Driver
is displayed.

Let’sadd Head Forward Acceleration and Head Pitch Accelerationto the Key
Results window:

> Click Kinematics, Head. The Variable Selection list for Head
Kinematics is displayed.

> Select Fwd Accel (Forward Acceleration) and Pitch Accel
(Pitch Acceleration) from the list .
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Next, let’s add the Head vs Head Rest contact force:

> (Click Contacts and choose Head, Head and Buick Skylark
4-Door Head Rest from the cascade menus. The Variable
Selection list for Head vs Head Rest contact is displayed (see
Figure 5-16).

3> NOTE: The first time Head is displayed (see Figure 5-16),
it refers to the Head segment; the second time refers to
the contact ellipsoid named Head that is attached to the
Head segment.
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Variable Selection: EDHIS, Buick Occupant

Object Mame : | Male Adult Driver ﬂ

Current Yanable :  Contacts

Output Groups : Yariables :
Kinematics Left Lower Arm ~ Contact »
Joints L5-51 Contact »
Joints, T12-L1 Contact z
Jointz, C7-T1 Contact defl
Joikts Atlas Cont F bat
Joints Right Hip Cont F norm
Jointz Right Knee Cont F frict
Jointz Right Ankle

Jointz Left Hip

Joints, Left Knee
Joints Left Ankle
Jointz Right Shaoulder
Jointz, Right Elhows
Joints Left Shoulder
Jointz Left E lbow

Clear &ll Selections | Clear Selection |

0k | Cancel |

Figure 5-16 Key Results Variable Selection
dialog, used for selecting variables to be
displayed in the Key Results window.

> Select Force from the list.
> Press OK to add the sclected variables to the Key Results
window.

Now, we’re ready to execute the event:

> Using the Event Controller, click Play to execute the event.
Allow the event to rununtil the vehicles separate, t=0.20 sec.

We have finished our occupant simulation. You may wish to view it a few
more times by pressing Reverse and Play. Note the time-dependent results
displayed in the Key Results windows. You might also wish to add additional
output variables to the Key Results window.
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Pedestrian Simulation

Using EDHIS to simulate a pedestrian impact is very similar to the previous
occupant simulation. Let’s proceed:

> Click Add New Object. The Event Information dialog is
displayed.

> Select Plymouth Voyager Van and the Female Adult
Pedestrian from the Active Vehicles list and Active Humans
list, respectively.

> Select EDHIS from the Calculation Methods options list.

> Edit the event name: Plymouth/Pedestrian Impact.

> Press OK to display the event editor.

Now, let’s set up and execute the pedestrian simulation event using EDHIS, as
shown in Figure 5-17.

> Using the Event Editor dialog, select Plymouth Voyager Van
from the Event Humans & Vehicles list, then select Sef-up
from the menu bar and choose Position/Velocity. The
Plymouth Van is displayed at the earth-fixed origin. Drag the
vehicle to its impact position, X=-20 ft, Y=37 ft, Yaw=0
degrees.

> Click the Velocity Is Assigned check box. Enter the Plymouth
Van’s impact speed, 35 mph.

Next, position the pedestrian.

> Select Female Adult Pedestrian from the Event Humans &
Vehicles list, then select Sef-up from the menu bar and choose
Position/Velocity. The human is displayed at the earth-fixed
origin.

-
g
14
(©)
-
=)
-

@ NOTE: The human is half buried in the environment; this
occurs because AutoPosition does not apply to humans.

> Usethe Position/Velocity dialog to enter the impact position of
the human relative to the earth-fixed coordinate system:
X=-10ft, Y=37 ft, Z=-3.5 ft, Yaw=9 0 degrees.

@ NOTE: Be sure to press <Enter>, otherwise, the entered
values do not take effect.
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Figure 5-17 Setting up the EDHIS Pedestrian Impact simulation

Now, let’s enter the initial velocity of the pedestrian:

> Click on the Velocity Is Assigned checkbox and enter the
velocity, 4 mph.

The final step in the event set-up is to set up contacts and assign combined
material property data for the human ellipsoid to contact surface interactions.
Let’s start with the Bumper.

> Ifthe Female is not currently selected in the Event Humans and
Vehicles list, click on it, making it the current object.

> Choose Contacts from the Set-up Menu.
> Under the Objects list, click Select All.
> Under the Targets list, click Select All.

> Below, in the Combined Material Properties section, first
select Bumper.

> Click Fdit to edit the combined material properties.

> Click Open to open a saved combined material property data
set.
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> Double-click on TypicalRoofPillar.matl to select it
and close the dialog.

> Click OK to accept the new material properties.
The Grille and Hood have the same material properties, so we will assignthem
together.

> Click on Bumper to deselect it and click on both Grille and
Hood to select them.

> Click FEdit to edit the combined material properties.

> Click Open to open a saved combined material property data
set.

> Double-click on TypicalDoorUndamaged.matl to
select it and close the dialog.

> Click OK to accept the new material properties.

Finally, we assign the material properties for the Female to Windshield
contact.

> Click on both Grille and Hood to deselect them and click on
Windshield to select it.

> Click Fdit to edit the combined material properties.
> Click Open to open a saved combined material property data

set.
-
> Double-click on TypicalWindshield.matl to select it é
and close the dialog. 8
> Click OK to close the Combined Material Properties dialog. IE

The pedestrian impact is now set up and ready to execute.

> Using the Event Controller, press Play to execute the event.
Allow the event to run until the pedestrian rebounds from the
collision and contacts the ground.

5> NOTE: EDHIS is design to simulate human occupant or
pedestrian motion up to the point of first impact. We
should therefore terminate the event no later than 0.15
seconds.

We have now completed the three events.
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Viewing Results

Now that we have produced our EDHIS simulations, let’s take a detailed look
at the results. The Playback Editor is used for reviewing and printing reports
for cach event in the current case, as well as for producing video output.

3> NOTE: The events simulated in this tutorial might be
included, along with the results from several other EDC
Reconstruction and Simulation Model tutorials, in the HVE
User's Manual Tutorial, Chapter 32.

[5° NOTE! In this tutorial, we will only review the output
reports produced by the EDHIS Buick Occupant event.
Feel free to view the EDSMAC4 and EDHIS Pedestrian
events as well.

EDHIS produces the following reports:

» Messages - A list of messages produced by the current run
» AccidentHistory - A table of initial and final positions and velocities

« Event Data - A table containing the collision pulse used in the EDHIS
event

* Human Data - A series of tables containing the human data used by
EDHIS

* Injury Data - A table containing the injury tolerances, followed by a
table containing values exceeding the allowable tolerances during the
event

» Vehicle Data - A series of tables containing the vehicle data used by
EDHIS

* Program Data - A table containing program control information

» Variable Output - A table containing time-dependent simulation
results

» Trajectory Simulation - A 3-D visualization of the event, displayed
at a user-selectable time interval

To view the output reports, we need to be in Playback mode:
> Choose Playback Mode. The Playback Editor is displayed.



Viewing Results Tutorial

Report Windows

The reports listed on the previous page are displayed by selecting Report
Windows. Each Report Window contains an individual report.

Repont Window EHE |

Active Events

EDSMACA, Buick ws Ford
(EDHIS . Buick Dccupant
EOHIS, Plyrmouth/Pedesztrian |

Whindow M ame
|EDHIS, Buick Dccupant

Select Output
I.-'l'-.cciu:lent Hiztary j

| ] I Cancel I

Figure 5-18 Report Window Information
dialog, showing the events (one EDSMAC4
and two EDHIS) in the current case.

To view the reports produced by the EDHIS Tutorial Case, perform the
following steps:

> Click Add New Object. The Report Window Information
dialogis displayed, as shownin Figure 5-18, and includes a list
ofthe active events (EDSMACH, Buickvs Ford, EDHIS, Buick
Occupant and EDHIS, Ford/Pedestrian Impact are the events
in this tutorial). The Report Window Information dialog also
includes the user-editable Report Window Name text field and
Selected Output option list.

> Select the desired event name from the from the Active Events
list.

> Click on the Selected Output option list and choose any of the
available reports.

> Press OK to display the report.

The selected report is displayed in a resizable window. The following pages
illustrate the reports produced for the EDHIS, Buick Occupant event.
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Messages

EDHIS produces several messages, depending on the outcome of the event.
Foracomplete listing and explanation of these messages, refer to Chapter 6.

=, Meszzages-EDHIS, Buick Occupant E3

s

ME33AGES

No Meszsages

Al A

Figure 5-19 Messages Report for EDHIS, Buick Occupant.

To view the reports produced by the £DHIS, Buick Occupant event, perform
the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.

> Select EDHIS, Buick Occupant from the Active Events list.

> Click onthe Selected Outputoptionlistand choose Messages.

> Press OK.

The Messages reportt is displayed for the FDHIS, Buick Occupant event, as
shown in Figure 5-19.
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Accident History

The Accident History report displays the earth-fixed positions and velocities
for the three human segments and the vehicle at the start of the run.

%5, Accident History-EDHIS, Buick Occupant

INITIAL CONDITIONS

777777 Vehicle ——---- === WEEEE ======= —=------ Head --—————- m=mmmm== IR =======

Position Velaoity Position Velooity Position Velocity Position Velooity

Linear (in} {mph) {in} {mph) {in) {mph) (in} {mph)
X 288.00 0.00 275.25 0.00 275.56 0.00 275.08 0.00

¥ 900.00 0.00 921.18 0.00 928.75 0.00 908.73 0.00

z -23.74 0.00 -35.886 0.00 -50.42 0.00 -27.62 0.00
Position Velocity Position Velocity Position Velocity Position Velocity

Angular (dedq) idegssec) ideg) (deg/sec) (deg) ideg/sec) (deg) ideg/sec)
Taw -90.00 0.00 -89.31 0.00 -89.56 0.00 -90.00 0.00
Pitch 0.53 0.00 30.52 0.00 20.53 0.00 0.53 0.00
Roll 1.19 0.00 1.39 0.00 1.27 0.00 1.19 0.00
[ ul G

Figure 5-20 Accident History Report for EDHIS Buick Occupant.

To view the Accident History report for the EDHIS, Buick Occupant event,
perform the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.

> Select EDHIS, Buick Occupant from the Active Events list.

> Click on the Selected Output option list and choose Accident
History.

> Press OK.

The Accident History report is displayed for the EDHIS, Buick Occupant
event, as shown in Figure 5-20.

5> NOTE: The Accident History report and several other
reports contain more information than fits into the default
window size. Use the scroll bars or resize the dialog to
view the entire report.
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Event Data

The Event Data report displays the accelerationpulse used in the EDHIS event.

2. Event Data-EDHIS, Buick Occupant

-

COLLISION PULSE J

Tinme x Nl = Fauw pitch roll

[=ec) gl 4} (g)  (degssec*~Z] [(deg/sec*Z) (degisec*i)
0.0000 0.0z 0.01 0.00 0,00 0,00 0,00
0.0100 -0.07 -3.79 -0.04 59,90 0.00 0.00
0.0110 0.1l6 -4, 06 -0.03 -96.64 0.00 0.00
0.0150 -0.01 -5.57 -0.05 35.44 0. 00 0.00
0.0z00 -0.02 -5.09 -0.06 35,42 0.00 0.00
0.0250 -0.03 -6, 50 -0.06 35,47 0,00 0,00
0.0300 -0.01 -6.81 -0.06 24, 47 0.00 0.00
0.0350 -0.03 -7.19 -0.07 30.79 0.00 0.00
0.0400 0.03 =7.45 -0.07 -3.32 0. 00 0.00
0.0450 0.04 =7.50 -0.07 -13.09 0.00 0.00
0.0500 0.0z =722 -0.07 0,18 0,00 0.00
0.0550 0.0z -56.73 -0.06 1.66 0.00 0.00
0.0600 0.01 -6.75 -0.06 7.94 0.00 0.00
0.0650 -0.0& -4, 86 -0.05 Z8.82 0. 00 0.00
0.0700 0.00 -1.04 -0.01 -8.37 0.00 0.00
0.0750 -0.00 0.01 0.00 -Z.85 0,00 0.00
0.0500 -0.00 0.01 0.00 -2.54 0.00 0.00
0.0900 =-0.00 0.01 0.00 -z.02 0.00 0.00
0.1000 =-0.00 0.01 0.00 -1l.61 0,00 0,00
0.1100 -0.00 0.01 0.00 -1.28 0.00 0.00
0.1lz00 =-0.00 -0.00 =-0.00 -1.02 0.00 0.00
0.1300 -0.00 —0.00 -0.00 -0.81 0. 00 0.00
0.1400 0.00 0.00 0.00 -0.64 0.00 0.00
0.1500 0.00 0,00 0.00 -0.51 0,00 0,00
0.1le00 0.00 0.00 0.00 -0. 40 0.00 0.00
0.1700 0.00 0.00 0.00 -0.32 0.00 0.00
0.1500 .00 0. 00 .00 -0.25 0. 00 0.00
0.1900 0.00 0.00 0.00 -0. 20 0.00 0.00
0.2000 0.00 0,00 0.00 -0.16 0,00 0.00

0.2500 0.00 0.00 0.00 -0.16 0.00 0.00 -
4 3

Figure 5-21 Event Data Report for EDHIS Buick Occupant.

To view the Event Data report for the EDHIS, Buick Occupant event, perform
the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.
> Select EDHIS, Buick Occupant from the Active Events list.

> Click on the Selected Output option list and choose Event
Data.

> Press OK.

The Event Data report is displayed for the FDHIS, Buick Occupant event, as
shown in Figure 5-21.
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Human Data

The Human Data report displays the human segment and joint properties, as
well as the human contact ellipsoid information.

2. Human Data-EDHIS, Buick Dccupant

Sequent
mber
0
1
2

Toint
Hun

Ellipsoid
Humber

OO

I

Sequent Hass eight
Heame (1b-sectz/in) (1b)
Tarsa 0.2144 62.8
Head 0.0239 11.5
leg 0.1621 62.6
-- Joint Elasticity -
Joine Taw Pitch  Roll
Nane
Neck 0.0 0.0 0.0
Hip 0.0 0.0 0.0
Ellipsoid Ellipsoid
Hame Attached To
Pelvis Torso
Abdonen Torso
Chest Torso
Heck Head

Head
Rt Upper Leg
Lt Upper Ley

Head
Leg
Leg

HIMAN SEGMENT PROPERTIES

—————————— Moments of Inertia --------—-

i Axis 3 Axis k hxis
(1b-sect2-in) [lb-sec*2-in) (lb-sect2-in)
12.2434 10,8569 4.0030
0.4011 0.4297 0.1571
0.6362 3.9840 3.82280

HUMAN JOINT PROPERTIES

HIMANW ELLIPSOID FROPERTIES

-- Center Coordinates ——

i a

{in) tin} iin}
-0.47 0.00 9.0z
-1.46 0.00 3.78
0.00 0.00 -4.31
-0.48 0.00 1.18
-2.22 0.00 -0.35
0.52 -0.33 0.00
0.52 0.33 0.00

Joint Loca

CG to Lower Joint G

Stop Elasticity —-----=  ---— Danping
Faw - Pitch + Pitch Roll Faw Pitch

2000.0 2000.0 2000.0 2000.0 0.1 0.1

2000.0 2000.0 2000.0 2000.0 0.1 0.1

(in}
9.65
5.03

35.0
0.0 -

---- Semiaxis Length ----

i
(in)
4.72
4.33
4.83
2.40
3.91
11.75
11.75

a
(in)
6.94
£.09
6.45
2.40
3.07
3.08
3.05

X

iin)

4,32
3.34
7.1z
4,38
5.68
3.08
3.08

- Pitch + Pitch

Lo b

tions —---------
G to Upper Joint
(in}
11.44

7.55

Stop dngles —-----——

-35.0  15.0  25.0
115.0  25.0  40.0

Figure 5-22 Human Data Report for EDHIS, Buick Occupant.

To view the Human Data report for the EDHIS, Buick Occupant event,
perform the following steps:
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> Click Add New Object. The Report Window Information

dialog is displayed.

> Select EDHIS, Buick Occupant from the Active Events list.
> Click on the Selected Output option list and choose Human

Data.

> Press OK.

The Human Data report is displayed for the EDHIS, Buick Occupant event, as
shown in Figure 5-22.
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Injury Data

The Injury Data report displays the results of injury calculations that compare
simulated tolerance levels with those specified for the human.

El Injury Data-EDHIS. Buick Occupant
INJURY TOLERANCES ﬂ
[User-Azsigned)
Head Injury Criterion (HIC): 1000
Head Pitch Concussion (deg/sect2): 114591.6
Head Side Acceleration (ogf: 46.0
Chest Force (lhb): 1800.0
Chest A-P Acceleration (g): 60.0
Chest Severity Index (g): 25.0
Axial Femur Load (lh): 2250.0
Torso Belt Load (combined, lhj: 1900.0
Lap Belt Load (combined, lhj: 1550.0
JOINT INJURY
[Maximm Range of Motion)
——————— Neck ------- ——===== Hip =====---
Waw Pitch Roll Fau Pitch Roll
Flexion (deg): -40.0 -40.0 -30.0 -75.0 -1z0.0 -45.0
Extension (deg): 40,0 20.0 30.0 75.0 30.0 45,0
PREDICTED INJURIES
T start T end Duration
Juantity Feak [sec) [sec) [sec)
Head Pitch Concussion 144925.0 0. 1040 0.1070 0.0030 -
i ;I_‘

Figure 5-23 Injury Data Report for EDHIS, Buick Occupant.

To view the Injury Data report for the KDHIS, Buick Occupantevent, perform
the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.
> Select EDHIS, Buick Occupant from the Active Events list.

> Click on the Selected Output option list and choose Injury
Data.

> Press OK.

The Injury Data report is displayed for the £DHIS, Buick Occupant event, as
shown in Figure 5-23.
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Vehicle Data

The Vehicle Data report displays the contact properties (locationand physical
propetties), collision pulse and restraint systems parameters.

5, Vehicle Data-EDHIS, Busck Decupant

VEHICLE CONTACT PROFERTIES j
-~ Elaacic Conacanta - Dnaping  Penten M mm fnlnnd
Cancact Concace Linear  uadzacic Cubite femar  Limit  Edge Foree Slope  Direceion
Humber Hnar (In/in)  (ib/in*2)  [Ib/in*3)  (lB-aee/in) [in)  Comac (in) [1b/1n} Facing
0 Seat Dotton 51,85 (] 24 oo 4,00 0,500 L0DOO0D.0  1000000.0 LEMIND
1 Geat Dack 51,25 0.67 0.24 u.o0 4,00 U500 lODODUD.U 100000 IR FRORT
2 Heéed Rest 51,25 U.57 0.24 0.0 4,00  0.500 lODOODO.U  1000000.0 LN FRONT
VEHICLE CONTACT LOCATIONZ
Widdie Corner - Third Corner Firar Cornee

Concact Conrace Time % ¥ £ ® ¥ T * ¥ ®

haber Hame (2ec) {in) (in) i) 11n}) [an) i) (1n) 1] (1n}

0 Seat Uotton  U.0000 =300 -300 =20 -3.00 -2 -2.00 -23,00 =300 1.00

1 Jeat Usck  0.0000 =2L.00 -23.00 Z.00 -20.00  -23.00  -18.50 =200 ~3.00 2,00

2 Head Rest 0.0000 =26.00 -19.00 -Z1.00 ~28.50 -19.00 -Z5.00 ~28.00 =7.00 -21.00

BELT RESTRATHT SYSTEM
[N Belea Tracalied)
AIFUAG FESTRAINT SYSTER
[Nu Airbag Installed)

|
o G

Figure 5-24 Vehicle Data Report for EDHIS, Buick Occupant.

To view the Vehicle Data report for the EDHIS, Buick Occupant event,
perform the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.
> Select EDHIS, Buick Occupant from the Active Events list.

> Click on the Selected Output option list and choose Vehicle
Data.

> Press OK.
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The Vehicle Data report is displayed for the FDHIS, Buick Occupant event, as
shown in Figure 5-24.
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Viewing Results

Program Data

The Program Data report displays the simulation controls and other program

control information.

L‘A; Program Data-EDHIS, Buick Occupant

GENEEAL INFORMATION

EDHIS Verszion Number:

2.4L

SIMULATION CONTROLS

Max Simulation Time [sec)
Max Timestep [(sec):

Output Interwval [(sec)
Starting Method:
Predictor-Corrector Method:
Velocity Change Limit:
Acceleration Change Limit:
Min Acceleration:
Velocity Conwvergence Crit:
Maximum Bisections:

Time Epzilon (sec)

2l

0. 2500

0.0005

0.0050
Modified Punge-Eutta
Milne-Hamming
0.0000000
0.0000000
0.0000000
0.1z00

1z
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Figure 5-25 Program Data Report for EDHIS, Buick Occupant.

To view the Program Data report for the £DHIS, Buick Occupant event,

perform the following steps:
> Click Add New Object. The Report Window Information

dialog is displayed.

> Select EDHIS, Buick Occupant from the Active Events list.
> Click on the Selected Output option list and choose Program

Data.
> Press OK.

The Program Datareportis displayed forthe FDHIS, Buick Occupant event, as

shown in Figure 5-25.




Viewing Results Tutorial

Variable Output

To view the Variable Output report for the EDHIS, Buick Occupant event,
perform the following steps:

> Click Add Preview Window. The Preview Window
Information dialog is displayed.

> Select EDHIS, Buick Occupant from the Active Events list.

> Click on the Selected Output option list and choose Variable
Output.

> Press OK.

The Variable Output report is displayed for the EDHIS, Buick Occupant event.
The table is initially empty, so the next step is to select the time-dependent
results we wish to display in the table.

Variable Selection

The purpose of our study is to determine the potential for head or neck injury,
so let’s select head position and velocity and forward and pitch accelerations
from the Kinematics output group. Let’s also add head vs headrest contact
force from the Contacts output group. To display these variables:

> Click on Select Variables in the Variable Output window. The
Variable Selection dialog is displayed.

> Click on the Object Name option list and choose Male Adult
Driver. The Human Variable Groups list is displayed.

Let’s add the Kinematics variables first:
> Click Kinematics, Head. The Variable Selection list for Head
Kinematics is displayed.

> Select x,,z positions, pitch orientation, Fwd Velocity, Pitch
Velocity, Fwd Acceleration and Pitch Acceleration from the
list.

Next, let’s add the Head vs Head Rest contact force:

> Click Contacts and choose Head, Head, Buick Skylark
4-Door, and Head Rest from the cascade menus. The Variable
Selection list for Head vs Head Rest contact is displayed (see
Figure 5-26).
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Figure 5-26 Variable Selection dialog, used for selecting the results displayed in the Output

Report.

5> NOTE: The first time Head is displayed (see Figure 5-26),
it refers to the Head segment; the second time refers to
the ellipsoid named Head that is attached to the Head

segment.

> Select Cont I tot (total contact force) from the variable list.
> Press OK to add the selected variables to the Variable Output

window.

The Variable Output report for the FDHIS, Buick Occupant now includes
Forward and Pitch Head Accelerations and the contact force between the
headrest and head, as shown in Figure 5-27. Feel free to use the above steps to
add additional parameters to the variable output table and view the results.
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EDHIS Viewing Results

Trajectory Simulation

The Trajectory Simulation provides a 3-dimensional visualization of the
vehicle and occupant motion during the event.

2, Traj Sim-EDHIS. Buick Occupant

Rotx Roty [T LTI Zoom ¢] | »]| 27.0 Dolly

Figure 5-28 Trajectory Simulation for EDHIS, Buick Occupant.

To view the Trajectory Simulation for the EDHIS, Buick Occupant event,
perform the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.
> Select EDHIS, Buick Occupant from the Active Events list.
> Click on the Selected Output option list and choose Trajectory
Simulation.
> Press OK.
The Trajectory Simulationviewer is displayed for the FDHIS, Buick Occupant

event (see Figure 5-28). The human and vehicle are shown at their initial
positions.
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To visualize the motion, perform the following steps:
> Click Play (single right-arrow). The simulation begins and is
displayed at the current Playback output interval.
> Click Pause. The simulation stops.

> Click Reverse (single left-arrow). The simulation plays in
reverse.

> Click Pause. The simulation stops.

> Click Rewind (left arrow with bar). The simulation returns to
the start.

> Click Advance to End (right arrow with bar) the simulation
advances to the end of the run.
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EDHIS Viewing Results

Prinfing

The final step is to print the above reports. Printing reports is simple. All youdo
is choose a report and print it. For example:

> (Click the dialog header for Variable Output - EDHIS, Buick
Occupant. The dialog header is highlighted and the Variable
Output window pops to the top of the display (if it isn’t there
already), indicating it is the current window.

> Click on the File menu and choose Print. The Print dialog is
displayed, allowing the user to select from several available
options.

5> NOTE: Alternatively, you can click on the print icon in the
upper menu bar.

> Press OK. Variable Output report is printed on the system
printer.

That’s all there is to it! You can print any other report using the same two steps
described above.

53> NOTE: The Print dialog provides several options. Refer to
the Windows or Printer User’s Manual for more
information.

[I5° NOTE: For several reports it may be best to print in
landscape rather than portrait mode.

53> NOTE: The font size of both the printed reports and
screen display may be edited by clicking on the Options
menu and choosing Preferences. Use the Font Size
option list to change the size.



